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A.1 System Requirements

Microsoft Excel 5.0 or higher
Microsoft Access 2002 (XP) , 2003 or 2007
Adobe Acrobat Reader

While there are not strict guidelines for PC processing speeds or RAM when
using the NT, a Pentium III processor with at least 512MB of RAM or better
will help to facilitate the following: 1) successful import of NFIP data when
there are hundreds or thousands of records; 2) successful appending of records
when there are hundreds or thousands of records; 3) faster record loading
times when browsing through records; 4) faster display of thumbnails when
browsing through records; and 5) faster download of pictures in the image

gallery.

Recommended screen resolution of 1024 by 768 pixels
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A2

Installation Instructions

Load the installation CD. If it does not automatically start, browse to the
installation CD folder and click NTSetup.exe.

The following screen will appear:

National Tool {NT} ¥3 Setup
The installation program Faor
- FEM& Mational Toal, version 3.0
: i= ready ko start,

Conkinue?

Yes

Click Yes to continue. The program installation will start.

Next, the Setup Wizard will appear. Click Next to continue.

fif NFMDCT Yersion 3.0 Setup E

Welcome to the NFMDCT
Version 3.0 Setup Wizard

The Setup Wizard will allow vou to change the way NFMDCT
Wersion 3.0 Features are installed on wour computer or even
ko remove MFMDCT Version 3.0 From wour computer, Click,
Mexk to conkinue or Cancel to exit the Setup Wizard,

= Back I Mext = I Zancel
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4. Enter your username and organization. This information is usually already filled
in.

fi NFMDCT Yersion 3.0 Setup = I

Customer Information

Please enter vour customer information

User Mame:

Organizakion:

< Back I Mext = I Cancel
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5. Select Typical as your Setup Type. Select the option Custom to change the
default installation folder.

i NFMDCT ¥ersion 3.0 Setup I

Choose Setup Type

Choose the setup bype Ehat best suiks your needs

Typical

Inskalls the mast commaon program Features, Recammended For
most Users.,

Custom

Allows users to choose which program Features will be installed
and where they will be installed. Recommended for advanced
UsErs,

< Back Mext = Cancel

Click Next to continue.
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6. Click Install to begin the installation process. To review your settings, click
Cancel to exit the Setup Wizard.

it NFMDCT ¥ersion 3.0 Setup =] I

Ready to Install
The Setup Wizard is ready to begin the Typical installation

Click Install ko begin the installakion, IF wou wank to review or change any af your
installation settings, click Back. Click Cancel ko exit the wizard,

< Back I Inskall I Cancel |

After clicking Install, the status window will appear:
ji NFMDCT Yersion 3.0 Setup [ =]

Installing MFMDCT Yersion 3.0

Please wait while the Setup Wizard installs MFMDCT Wersion 3.0, This may take
several minukes,

Skakus:

% Back Mext = | Cancel I
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7. When the installation process is completed, click Finish to exit the Setup Wizard.

fi NFMDCT ¥Yersion 3.0 Setup I

Completing the NFMDCT
Version 3.0 Setup Wizard

Click. the Finish button to exit the Setup Wizard.

= Back I Finish I Zancel |

If you have Access 2002 or Access 2007, the icon that appears in the Start > All
Programs list needs to be modified to point to the correct Microsoft Office folder.

To do this, go to Start > All Programs and right click on the NFMDCT_V3 icon. Select
Properties, and modify the target field to point to the correct Office folder (Officel2 for

Access 2007 or Officel0 for Access 2002).
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A.3 Installing the Repetitive Loss Property (RLP) Viewer

1. Open the Setup Disk.
2. Run the MapWinGISOCXOnly.exe program and follow the instructions.

3. Once the MapWinGISCXonly installation is done, open the Release folder
inside the Setup CD.

4. Run the Setup.exe file.
The RLP Viewer was developed using Visual Studio .NET. If this is the first
installation in the computer, it will start the deployment of Microsoft .NET
Framework. Just follow the instructions. At the end of the process, it could ask
to reboot the computer.

5. After rebooting the computer, if asked, the installation process will continue.

6. View the PowerPoint presentation in the Presentation folder on the CD.

7. Instructions for downloading shapefiles can be found in this file in the

presentation folder: RLP Viewer 2.0 GIS Data Formatting.doc or in Appendix
A3.1
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A.3.1 RLP Viewer 2.0 GIS Data Formatting

There are two steps involved before using the RLP Viewer: 1) obtaining your GIS
data and 2) formatting your GIS data.

Note: Also view the PowerPoint presentation in the Presentation folder on the
RLP Viewer CD.
Step 1: Obtaining your GIS data

1. Navigate your web browser to the URL.:
http://arcdata.esri.com/data/tiger2000/tiger download.cfm.

Next, select a state from the drop down list (Figure 1).

2 Download Census 2000 TIGER/Line Data - Microsoft Internet Explorer,

Fle Edt View Favorites Tools Help o

O © MR G| Lo derwns @3- % 3 - B E B

Adiress | ] bttp: farcdata.es comidakaltiqer2000/tiaer_dowrioad.cim v Be ks * & -

Google (G- v Goo@d M B~ ¥9 Bookmars~ Sh2blocked 9 Check ~ 4y Autelink + [ob Send o () Settings~
N Store | Contact Us | Careers ~

@ ESRI GIs and Mapping Software
| esu |

ArcData

Download Census 2000 TIGER/Line® Data

To begin your Census 2000 TIGER/Line shapefile download, select a state from the list
below and click Submit Selection, or click 3 state on the map image.

m L MNQT
Select a State: "l/" *—cr
NV

A 7 IL m% “‘\DE
ks
g

W A\ (s
lowa v )

Az OK
E "‘r.. AL nl oc
Submit Selection e
R “ R (. PR

pa, W

N

: =ESRI Business Information Solutions =Geography Network =Distributors Worldwide

I@ @ Internet

(Figure 1)
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2. From the next drop down list, select the county that pertains to your data,
click ”Submit Selection.”

2 Geography Network - Download Census 2000 TIGER/Line Shapefiles - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help 5
N A ™) e Yy A
Q- © [ AG Pwoo Fore @ 2-5 @ B H S
AddVESS@httD:J'ﬂarcdata‘esri‘comfdata/tigerZUDth\ger,state\ayer‘cfm v|cu Liks » & -
Google (G- v|Goo @ M B~ €9 bockmarks~ Bi2blocked | P check + 9 dutolick ~ s Send tor () Settings =
%, Store | Contact Us | Careers ~

@ ESRI Gis and Mapping Software
=

ArcData

Download Census 2000 TIGER /Line® Shapefiles

You have selected the state of Iowa. If you would like to download one or more data
lavers far a single county in Iowa, then select a county fram the list below. If you would like
to download a single data layer for one ar mare counties in Iowa, then select a layer

below.
Select by County OR Select by Layer
[Falk v |Select s Layer -

Submit Selection Submit Selection

Technical documentation for PL 94-171 and SF1 data:
LS. Census PL 94-171(PDF)
.S, Census Summary File 1 (SF11(PDF)
ESRI abbreviated PL 94-171(PDF)
PL 94-171 Quick Reference Guide
SF1 Quick Reference Guide

&] Done ® Internet

(Figure 2)
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3. From the list of available GIS data layers check the box next to:
“County200,” “Line Features — Hydrography,” and “Line Features —
Roads” (Figure 3). At the bottom of the page, click “Proceed to
Download” (not shown).

‘ 3 Geography Network - Download Census 2000 TIGER/Line shapefiles - Microsoft Internet Explorer

Fie Edb View Favortes Tools Help

P rack -

Iﬂ Igl D | A ) search ‘*:.:/Favuntas &

Address @'] hiktpef/arcdata. esri.comidata/tiger2000/biger_county. cfm?sfips=19

Er & 3

vB e ks T & -

Google (G~ v Goo @ M B~ ¥F Bookmarks~ Sh2blocked WP Check v Autolink o Sendtor () Settings~
T LUrTgres TUrar oastmels = TUOTT [N =] ~
[0 Congressional Districts - Current 7.3 KB
[0 County 1990 7.3KB
County 2000 7.3 KB
[0 County Census Divisions 2000 38.5 KB
[ Designated Places 1990 26.8 KB
[0 Designated Places 2000 31.1 KB
O Key Geographic Locations 979.0 bytes
O Landmark Paints 21KB
O Landmark Polygons 120.0 KB
Line Features - Hydrography 264,3 KB
O Line Features - Landmarks 5.3KB
[ Line Features - Misc, Transport 3.4 KB
[J Line Features - Non-visible 173.4 KB
[J Line Features - Rails 41.6 KB
Line Features - Roads 1.2 MB
O School Districts - Unified 24.1 KB
5165%?; Legislative District Lower 24.3 KB
5165%?; Legislative District Upper 16.3 KB
[ Traffic Analysis Zones 134.2 KB
[ Urban Areas 1990 12.8 KB
O Urban Areas 2000 277 KB
O Woting Districts 2000 78.4 KB
[0 Water Polygons 78.2KB v

&] Done

(Figure 3)

4 Internet
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4. At this page, click “Download File” (Figure 4). Download the data to the

desired folder location.

a Geography Network - Download Census 2000 TIGER/Line shapefiles - Microsoft Internet Explorer,

Ele Edk View Favorites  Tools  Help

Q- Q- [& @& ) search e Faverkes )| (- :4 BB 3

iddress | @] hktp:f)arcdata, esri.comjdatafti _final.ci Timeout=500 V‘ Be ks > & -
Google (G~ v coogd M B~ §F Bookmarks~ Ei2blacked  UF Check » 4y Autalink - () settings+
e

ArcData

Your Data File is Ready

You may now download the selected data to your local system. You will receive a .ZIP file
containing each selected data layer in compressed shapefile format, Extract each .ZIP file
to display the data layers

The Census 2000 TIGER/Line® data is provided under the terms of the ESRI Data
Disclaimer. By downloading the data, you are indicating your acceptance of the data
disclaimer.

Click Download File to retrieve your data file,

Download File

Technical Documentation for PL94-171 and SF1 Data:
U.S. Census PL 94-171(PDF)
U.5. Census Summary File 1 (SF1)(PDF)
ESRI Abbreviated PL 34-171(PDF)
PL 94-171 Quick Reference Guide
SF1 Quick Reference Guide

Download more Census 2000 TIGER/Line Data

&

(Figure 4)

Iﬁv

4 Internet
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5. After the download is complete, extract the individual WinZip folders
(Figure 5), then extract the shapefile components (Figure 6).

& lowa_Shapefiles

File  Edit

eBack % -J

Wiew  Favotites

Tools

Help

L@ pSearch h:‘ Folders v

Details

Eile  Edit

Address (I PiWATER_RESOURCESYFEMA_PROJECTS\RLP supportilowa_Shapefiles

Mame Size  Type Date Modified
File and Folder Tasks @at_tigeresrizzsﬂ 11935 1,419 KB WinZip File 7/25/2008 2:20 PM
kH19153 259 KB WinZip Fil 3972002 1:03 AM
1} Make a new Folder q !n !D !E 12
i D cty0019153 SKB  WinZip File 332002 9:37 PM
=] \'f\j':gs" this Falder to the CDka19153 1,144 KB WinZip File 3/8/2002 11:13 PM
readme 10KE HTML Document 3192002 2:26 AM
Other Places
I RLP support
ﬂ My Documents
'j Iy Computer
i-g ¥y Metwork Places
& |owa_Shapefiles (=1 £
Yiews Favorites  Tools  Help i-,.
e Back = -J Lw p Search lL Falders v
address |2 PWWATER_RESOURCES\FEMA_PROJECTSIRLP supportilowa_shapefiles i | ‘-) Go
MName ~ Size | Type Date Modified
File and Folder Tasks CDak_tigerestiz264111935 1,419KE  WinZip File 7}25(2008 2:20 PM
IkH19153 Z59KB  WinZip Fil 3/9/2002 1:03 AM
(=7 Make a new folder @ !n i !e 191
i X Z_Ecty'0019153 GKE WinZip File 3f8/2002 9:37 FM
=] 5\7‘:‘25'7 this folder to the CDkat91ss 1,144 KB WinZip File 3/5/2002 11:13 PM
@readme 10KE HTML Document 392002 2:26 AM
@EQI’IQISSRH Z34KB DEF File 1/5/2001 4:49 PM
Other Places kar19153kH 416KEB  AutoCAD Shape So...  1)8/2001 4:43 M
bgri9153kH 14KE AUSCAD Compiled ... 1/5/2001 4:43 PM
[C RLP suppart =\ tar19153ctyan 1KE DEF File 1/8/2001 4:50 PM
B My Dacuments tgr19153cty00 11KE AutoCAD Shape So...  1)8/2001 4:50 PM
'i My Compter bgri9153cty00 1KE AutoCAD Compiled ... 1/5/2001 4:50 PM
&) My Htwork Flaces =) tqr19153ka 2,994 KE DEF File 1/8/2001 4:43 PM
tar19153lka 2,109KE  AutoCAD Shape So...  1/5/2001 4:49 PM
bar19153ka 174KB  AUtoCAD Compiled ... 1/G(2001 4:49 PM

(Figure 6)
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Step 2: Formatting your GIS data

For each GIS layer you will see a collection of 3 files with the same name,
but different file extensions (Figure 6 in Step 1). This collection of files
that comprise each GIS layer needs to have the same name in order to
work properly. The naming convention needs to match the example on
page 8 of the RLP Viewer 2.0 manual. The minimum requirement is the
county boundary shapefile.

For our example (and for all data retrieved from ESRI ArcData site) the
file name changes should be:

Original File Name New File Name
tgr19153cty00 IA_POLK_County
tgr19153IkA IA_POLK_Roads
tgr19153IkH IA_POLK_Streams

Your shapefile components also need to have the appropriate name and
attribute fields in order for RLP Viewer 2.0 to map your properties.

Layer Field Name Field Type Description
Properties PROPLOCATR | Text (50) It corresponds to the Property Locator
number in the NT database
Roads TIPTEXT Text Text to be displayed as a “tip” when the
user stops the cursor over a street segment
NAME Text For labels
Stream TIPTEXT Text Text to be displayed as a “tip” when user
stops the cursor over a stream segment
NAME Text For labels
Q3 FLOODWAY Text For identifying flood way
ZONE Text For thematic coloring the flood map and

to be displayed as a “tip” when the user
stops the cursor over a flood polygon.

Community | TIPTEXT Text Text to be displayed as a “tip” when user
the stops the cursor over a community
NAME Text polygon
For labels
County NAME Text For selecting which new property feature

will be added to the properties shapefile
avoiding points outside the extent of the
county polygon.

(Figure 7)
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1. To add a field, open the .dbf file using Excel. Right click on the .dbf
file and choose the option “Open With.” Select Microsoft Office Excel
(Figure 8).

Qpen With

- ] Choose the program you wank ko use to open this file:

File:  IA_POLK_County.dbf

Programs

@ Recommended Programs:
[Emicrosoft o
@ Other Programs:
- Adobe Acrobat 8.1
D Arcalobe Application
a Archap W
& ArcReader.exe
@ Arcscens Application
é Internet Explorer
* Trfaniisw
@ Microsoft Office Access

Pl natce o CL ACE o ToCoroil

>

v

[[] always use the selected program ta open this kind of file

If the program you wank is not in the list or on your computer, you can look
for the aporopriate program on the Weh,

(Figure 8)

2. You should see the following (Figure 9):

E3 Microsoft Excel - IA_POLK_County

Cid] Ele Edt Yew Iwet Fomet Tooks Data Window Help  Adobe FOF Type aquestion for help =
R G e e sl e B 20 o|B rU|===5s %j=o-0-A- B
malicl

Al s A& D

al 8 [ ¢ [ o [ [ F [ 6 [ W [ 7 T 5 7T KT L [ MM T NTOTPTZH
IDIFIPSSTCO STATE COUNTY
119153 lowa | Polk

EESEEEES

=

)

)

=

o

o

=i

@

ralra =
iR i)

wiea|wafrofmalralrafro i n
F3|=| S| o || m o = o

w
o

Lo
or| =

v
1 ¢ » n\IA_POLK_County / < | 3l
Ready MUM

(Figure 9)
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3. Next, type “NAME” into the next empty column header. In order for
the .dbf file to save correctly, select “Insert” from the main menu, then
“Name,” then “Define.” Delete all names in the workbook and select
“OK” (Figure 10).

B3 Microsoft Excel - IA_POLK_County |ZHE|§‘

(] Fle Edt View Insert Format Tools Data  Window Help  AdobeFDF Typeaquestionforhelp [+ o @ X

NEERASR @B 9-8 = sme i sw o|B T uU|=S==H$w=E -5 A- K

al 8 [ ¢ [ b [ E [ F [ 6 [ W [+ [ 4 [ w [ ¢ [ w [ N [ 0o P
IDIFIPSSTCO |STATE COUNTY NAME
1719153 lowia Polk

Define Name.

@ ||| o oo

!

=}

Names in workbook:
oK

Datahase

=)

@

Close

=

o

Delete

=

=

@

X
=1

Refers to:
=18_POLK_County!$A$1

s M

JE) Y Y e ) P PR P A P P PR P
| ||| =& | | o || B G| | =

=
-
-
=1
2
Ead
jw]
=]
=
=
ES
=3
S

< | >
CAPS NUM

o
8
=8

2

(Figure 10)

4. Save the file and exit Excel. When prompted choose to save the file in
the DBF 4 format (Figure 11).

Microsoft Excel g|

Ia_POLE_County.dbf may contain features that are not compatible with DBF 4 (dEASE Iv). Do you want to keep
- the warkbook, in this Format?
\!) + To keep this Format, which leaves out any incompatible Features, dlick Ves.
« To preserve the Features, click Mo, Then save a copy in the latest Excel Format,
« To see what might be lost, click Help,

[ oves | [ Mo l [ Help

(Figure 11)
5. Repeat these steps to add the required fields for the streams and roads
files, adding the appropriate column headers from Figure 7.

Your GIS data is now properly formatted for use with RLP Viewer
2.0.
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A4

NT Folder Organization and Maintenance

By default, an NT database and a documentation folder will be installed into
C:\Documents and Settings\<username>\NFMDCT V3, but you can change
this location during installation to another folder on your hard drive or network.
The documentation folder within the NFMDCT _V3 folder is called NFMDCT.
The nested NFMDCT folder initially contains only the NT documentation;
however, it is also the repository for all images and documents uploaded into the
NT.

If you install to the default folder and want to move it later to the network or other
location, you can do so without any problems. You do not need to reinstall from
the CD to the network.

The NT can store and organize properties in any way you prefer: by community,
county, state, or FEMA region. How you work with field inspectors and others
who use the data will determine the best way to set up your folder structure. Keep
the following in mind:

e Always keep one database (the master) up-to-date with the latest field
inspections and NFIP data. Updating multiple databases can be confusing
and time-consuming. See also Section 4.4.7.1, Updating a Master
Database from a Subset Database.

e Create subset databases from the master database as needed (by state,
county, community, etc.) for field inspectors, community officials, or
other users. Creating subset databases from the master ensures that you
will always have the most recent data.

e Organize the field inspector’s databases by date so you can rebuild the
master if necessary.

e Organize downloaded NFIP spreadsheets by date.

e You will need an empty version of the NT database each time you want to
create a subset database, so copy the NFMDCT_V3_Empty.mdb database
from the installation CD to a folder on your local PC or network so it’s
easy to retrieve when needed.

e |If there are other users who need to use the master database on the
network, provide a separate copy to work with instead of the original.
This will help to protect the master database from accidental data and/or
file corruption.

e See the graphics below for a few ideas for folder structure. These are only
suggestions; do what works best for your needs.
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= I MFMDCT DATA
1 _EmptyDatabase
=l I alabama
[= |1 From_Field
[ 2007-06-01
1 MFIP Downloads
) MFMDCT
[= [y To_Field
51 NFMDCT
-1 Florida
) NFMDCT
1 aeorgia
1 Kentucky
1 Mississippi
1 Marth Caralina
1 REGION IY Masker
=) MFMDCT
1 South Carolina
1 Tennessee

m

0= &FHHME

Folders organized by State

= 1) MFMDCT DATA
SRRt abases
1 _EmptyDatabase
= I Alabama
) NFMDCT
i1 Florida
=l [ aeorgia
) MFMDCT
1 Kentucky
1 Mississippi
1 Morth Caralina
[=] [ REGION IV Master
=) NFMDCT
1 South Carolina
1 Tennessee
=l |2 From_Field
= I AL
[ 2007-06-01
= AL
1) MFIP Downloads
[=] ) To_Field
= I AL
[ 2007-05-01
= FL

Folders organized by Function

Appendix A

If you have access to a network, it’s strongly recommended that you store your
databases on the network. It not only provides a regular backup of the data but
also allows for unlimited storage capabilities.

As images and documents are added to the database, you will need an increasing
amount of disk space to store them. How much space is needed depends upon the
size and quantity of images/documents.

If you do store the databases on your local PC, make sure you back it up
frequently to an external device.
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A.5 Enhancements Made to Version 3.0

1. NEW FEATURES

a.

Added the ability to Export a Property data Template spreadsheet. The
spreadsheet will be populated with all of the data fields in the NT. It can
then be modified and imported back into the NT. The only fields not
importable are Possible Mitigation Measures Observed and the Certifiers
Information.

Added the ability to Export Claims and Flood Event information into an
Excel spreadsheet.

Added the last 10 properties worked on to the File menu.

Added a Merge feature to the Utilities menu. You can now merge the data
entry fields from one property into another.

Added 4 new Tutorials: Importing NFIP Data into the NT, Creating a
Subset NT Database, Appending Data into an Existing NT Database, and
Maintaining a Master Database.

Added the ability to print reports to PDF without having a PDF printer.
During the NT installation, two additional files will be installed called
DynaPDF.dIl and StrStorage.dll. They will be installed in the same folder
as the database. If you move the database and it can’t find the files, you
won’t be able to print to PDF without a PDF printer.

Added the ability to track multiple site visits on the Data Collection
screen.

Added a Photo Gallery that is available from the View menu in Limited
and Detailed views, or from the Utilities menu.

2. SCREEN CHANGES

a. Made the Property Locator/RL# red and bolded and added
“SRL(indicator)” after it to indicate SRL properties.
b. Added the NFIP Data As of Date (from the collections screen) to the
Limited View / NFIP Address section.
c. Added Insured Status from the Insurance Screen to the Limited View /
NFIP Address section.
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The Data Collection screen will now collect multiple site visit information
as well as track data changes made through the screen interface or through
the Property Data Template import process. To enter site inspection
information, click on the inspectors name or date in the Limited View.

Added the Data Collection screen and FEMA Regions to the View Menu.
Added new buttons to the bottom of the Limited and Detailed Views:
Find Properties, Show All Properties, Go to Detailed/Limited View, Save,
Close, Go to PL# and Go to Record #.

Made the thumbnail image larger and it will now appear in the last place it
was dragged.

. All screens that open from the View menu can be sized and left open as

you scroll through properties.

The thumbnail will stay open when you switch between limited and
detailed views. You can also turn the image on and off from the detailed
view as well as limited.

Reformatted the Help screen and the Help menu. Added sections for
Documentation, Tutorials, Tools and Helpful Links. Added a link to the
RLP Viewer program.

Added Last Claimant Name (Revised) to the Insurance screen.
Added Streambed Elevation from FIS to the detailed view.

If notes exist, they will be displayed when the mouse is moved over the
Notes buttons in Limited and Detailed views.

Added a “551” image next to each field that is needed in order to run the
FEMA 551 worksheets.

Added “Clear All” buttons next to the HVAC, Duct Work and Potential
Hydraulics Impacts. This is the only way to ‘deselect’ all options.

FIND SCREEN - Reformatted into Tabs.
i. Added Zone Insured In, Inspection Date, NFIP Data as of Date,
Severe Rep Loss Indicator and Community ID starts with.
ii. When you press Enter it will automatically perform the Find.
iii. Reformatted and grouped items.
iv. Fixed a bug in the Find Number of Claims payments.
v. Added Last Claimant Name and Last Claimant Name (Revised).

User’s Guide

A-19 August 2008



National Flood Mitigation Data Collection Tool and RLP Viewer Appendix A

3. NFIP IMPORT
a. Importing additional fields from the NFIP spreadsheet: Severe Rep Loss
indicator, County and Local Property Identifier. The Local Property
Identifier is being imported into the Local Lot/Parcel ID field (detailed
view). The user can still overwrite the data. If there is a value in the field
when the NFIP data is imported, it will NOT be overwritten with the NFIP
data.

b. Added a third report produced in the NFIP Import Process. Itisa
summary report by CID showing the number of properties per CID in the
database before the Import, how many were Imported, the properties not
Imported, and the new properties Imported.

c. The community name, CID, city, county, state and zip fields will be filled
in on the Limited View / Address Updates section. This will happen only
for new records, or if these fields are blank.

d. Added the ability to cancel an import.

4. APPEND PROCESS
a. Added an Append Options screen which provides additional ways to
append the data.

b. Modified the Append process to capture “53 — File Not Found” errors. If
the file isn’t found then it is added to a new “Missing Images/Document”
report. The new report will display after pressing the Report button and
closing the first report.

c. When Appending into another database, the NT documentation files
(user’s guide, tutorials, etc) will also be copied to the NFMDCT folder (if
they don’t currently exist).

d. Fixed an issue when appending the same data into a database causing the
images to be duplicated.

5. REPORTS
a. Added the following new reports: FEMA 551 worksheets A and B,
AWS501, Missing Images and Documents and Mitigation.

b. Changed the Severe Rep Loss report screen drop-down box to list each of
the SRL types.
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C.

e.

f.

The SRL type was added after the property locator number on all of the
reports.

Modified the report criteria screen for the Photo summary report so you
can sort the properties by Rep Loss #, Community Name or CID number.
You can get to this screen through the main menu — Reports option. Also,
only properties with photos will now appear in the list.

Reformatted the Basic and Severe Rep Loss reports.

Added the Inspection Date to the Properties Requiring Action/Update
report.

6. DATA STRUCTURE CHANGES

a.

Widened the Tax id field (detailed view) from 30 characters to 50
characters.

Widened the filename field for document names when loading pictures
and documents from 42 characters to 247 characters.

Widened the Local Lot/Parcel ID field in the Additional Site Information
Tab of the Detailed Data view to 75 characters.

7. MISCELLANEOUS

a. Replaced the term “BureauNet” with “NFIP.”

b. Changed the View menu to say Detailed View OR Limited View, not
Detailed Data.

c. Changed the CID field to a character field throughout the system in order
to display the leading 0.

d. Removed the # in all filenames that are uploaded to the tool and replaced
it with “_”.

e. Eliminated having to be administrator to load the tool — removed all OCX
and DLL files that had to be registered.

f. If there any entries in the Mitigation Updates Field boxes in the Limited
View, the “Updates Made” checkbox will automatically be checked when
the property is saved. Also when saving the Limited View, the system
will check the field mitigation actions to ensure they have been
appropriately entered.
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g. Added progress bars to several processes.

h. Modified the transition process between the Limited and Detailed views to
be smoother and quicker.

i. Fixed several bugs throughout the system.
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